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Desktop layout

Items on your desk, including equipment and resources, should be arranged within 
easy reach.

Your desk area can be divided into three zones:
• the optimum reach zone – the area closest to you, where your hands operate most of

the time
• the maximum reach zone – further away, but still close enough to reach comfortably
• the outer reach zone – where you may have to bend forward or stand to reach items.

Make sure your desk is organised so that frequently used objects, such as your keyboard, 
are close to you. Intermittently used objects, such as your phone, should be out of the way 
but still within easy reach. Other resources used less frequently, such as in- and out-trays, 
should be in the outer reach zone.

Adjust your equipment and posture
When your posture is poor, you may suffer from aches and pains. Spending a long time in 
the same position can put stress on your body and this can be made worse if you are in an 
uncomfortable or poorly supported position. These symptoms may start out very slight, but 
if you continue to use poor posture they may get worse and become intolerable. They may 
result in cumulative stress given the constant stress on your muscles, nerves or tendons. 
When setting up your workstation, you need to make sure your posture will not cause you 
pain or discomfort. The equipment you use needs to be adjusted to suit your body shape and 
size, and the tasks you are doing.

You have already looked at adjusting your screen and chair. There are other office tools that 
can help your posture. These include the following items.

Footrests

A footrest may be necessary if you can’t 
place your feet comfortably on the floor. 
Footrests allow your feet to rest at the 
correct height and on a tilting angle, which 
prevents strain on the lower back. 

Headsets

If you use a telephone for long periods of 
time, it is a good idea to use a headset. A 
headset will keep your neck straight and 
your arms free. Headsets prevent you from 
bending your neck to support the telephone 
handpiece.
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Minimise energy use
Wasting energy also costs organisations and the planet a great deal. Many organisations 
have developed policies and procedures to save energy. These include:
• providing training programs on smart energy practices so that employees can practise

energy efficiency
• turning off equipment when not in use
• using power-save functions for equipment
• refilling toner and ink cartridges from printers.

Resource conservation
Here are some tips for practising conservation.

Resource conservation tips

 • Use the power-save function on printers when they are not in use.
 • Print and copy on both sides of the page, where possible.
 • Use recycled paper (paper used on one side) in the photocopier and

printer for rough drafts.
 • Use recycled paper for telephone messages.
 • Place a recycling bin near the photocopier.

Practice task 2
1. List three policies developed to minimise paper wastage at your organisation, or one you are

familiar with.

2. List three policies or procedures developed to minimise energy use at your organisation, or one
you are familiar with.
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Alter data
Once you have entered data, you may have to 
alter it to correct errors or update it for changing 
organisational requirements. You can alter the 
information in a cell by selecting the cell and directly 
entering the new information, or by using the 
Formula Bar:
• Click in the E4 cell Clear Profit. This cell is now

current.
• This cell’s content will be displayed on the

Formula Bar.
• Click on the Formula Bar to select it, or press the

F2 key on the keyboard. Change the word ‘Clear’
to ‘End’.

• Press Enter or click the Enter tick  on the Formula Bar to confirm 
the change.

• Select one of the numbers you have entered in the Income column. Press the Delete key
to delete the information. Retype a new number.

• Save your changes and close your worksheet.

Select cells
Once you have entered data into a worksheet, you will need to select data in order to format 
it or perform calculations. You may need to select some or all of the data on a worksheet. 
When data is selected, it is highlighted on the screen. The following information describes a 
number of techniques for selecting cells.
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Producing a spreadsheet means creating it and having it ready for your colleagues or 
supervisor to read. When producing spreadsheets, you need to check the data you 
have entered for errors and make sure the content and format suit your organisation’s 
requirements. For example, you may need to proofread the data manually or use the 
spellchecker installed in the software you use.

If you have been asked to produce a spreadsheet, be aware of when the spreadsheet is 
needed, so you can have it completed on time.

If you experience difficulties when producing a spreadsheet, you need to know where to go 
for help; for example, you could use a paper-based manual or go online. You should know 
which websites have up-to-date information about the software you are using.

In this topic you will learn how to:
2A Enter, check and amend data while maintaining consistency of design and layout
2B Use software functions to format spreadsheets
2C Use and test formulas to confirm output meets task requirements
2D Overcome problems with spreadsheet design and production



 © Aspire Training & Consulting 35

Topic 2
Create simple spreadsheets

To check errors in labels, you can use the Spelling function   under the Review tab. This 
will pick up words you have misspelt, but will not help you with product names or customer 
names and addresses. The function will also not help where a word is spelt correctly but is 
the wrong word; for example, ‘they’re’ instead of ‘their’.

Make sure you manually check your spelling and cross-check it with any documentation 
you used to enter the data. For example, you may have been given a printout of all customer 
names that were to be entered. Once you have entered the customer names, check them for 
accuracy against the printout.

Validation rules
When creating a worksheet, you can add validation rules in cells to ensure that anyone else 
who adds data has to make entries in the correct format.

For example, you may want only numbers or dates to be entered into certain cells. To do 
this, you need to set validation rules in your worksheet.

Example: set validation rules
Follow these steps to set validation rules.
1. Open an Excel worksheet. Look at the following sample and enter the same data into your

worksheet. This worksheet is to record product codes that have one letter and two digits.
The month columns record the units of products sold in that month. Save the worksheet as
‘Validation rules’.

continued …
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… continued

2. Look at these examples of a worksheet and documentation used to enter data.

Customer accounts worksheet

Customer documentation

Customers Balance

Smith 55.00

Carter 4,000.00

Andrews 3,455.00

Phillips 3,000.00

Elliot 2,500.00

Franks 5,000.00

Luie 34.00

Cross-reference the worksheet with the customer documentation. Count how many errors there 
are in the worksheet.

3. What should customer Smith’s new balance be?

4. Recreate the ‘Customer accounts’ worksheet with accurate information.
5. Select cells B5 to F15 from the ‘Validation rules’ worksheet from the previous example. This

covers all the values to be entered under the five months. Add a validation rule to these cells that
ensures only numbers can be entered into them. Write an error message to help colleagues if
they try to enter the wrong data. Test your validation rule to make sure it works.
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Example: alignment of a spreadsheet
The default alignment for printing a spreadsheet is that the data is aligned to the left and top of the 
page in line with the margins. In many cases, especially in smaller reports, it is preferable to centre 
the data on the page both vertically and horizontally. 
To do this, first preview the spreadsheet to check what the information will look like before it is 
printed out. 
1. To preview, select Print from the File tab.
2. Select the Page Layout tab.
3. Select the Margins drop-down menu, then select Custom Margins.

4. Check the options to centre on the page – both horizontally and vertically. The display in the
dialog box shows how the changes will appear in the spreadsheet. Select OK. When printed, the
data will now be aligned vertically and horizontally on the page.



 © Aspire Training & Consulting 47

Topic 2
Create simple spreadsheets

… continued

5. Select Garamond, Bold Italic, 18. Click OK.
6. Select cells A4 to F4. This should cover all the headings of your columns.
7. Using the Font tools, change the font selections. Select Garamond, Bold, 14.
8. Select cells A5 to A16. This should cover all the month labels.
9. Using the Font tools, change the font selections. Select Garamond, Bold, 12. Click OK.
10. The worksheet should now look like the following example. Adjust the column widths to suit the

formatting.

Example: format values
Earlier you learnt that a number entered into a cell is called a value. 
The following steps show how to format values:
1. Open the ‘Current clothing’ worksheet.
2. Select cells B5 to F16. This will select all the cells where values have been inputted.
3. From the Home tab, select Number to access the Format Cells dialog box.

continued …
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… continued

2. Create this spreadsheet, which provides a summary of sales results for sales consultants at
‘Henry Lewis Consulting & Co’. Then complete the tasks that follow.

 • Use Fill to create the list of months.
 • Alter the December figures as follows:

 – Hannah: 5909
 – Joe: 2343
 – Fredrick: 1231
 – Simon: 2324
 – Carolyn: 4358
 – Nim: 13210

 • Save the document and name it ‘Henry Lewis – sales results’.
 • Practise using the alignment tools to adjust how the data sits within the cells – alter the width

and height of columns and rows to see how using the alignment tools alters the viewed data.
 • Use the Merge & Centre tool to create headings for the spreadsheet.
 • Centre the data on the page both horizontally and vertically.
 • Print Preview the report.
 • Change the orientation from portrait to landscape.
 • Preview the report.
 • In a new column labelled ‘Summary monthly totals’, calculate the total sales figures for each

month. For example: =B6+C6+D6+E6+F6+G6. (Make sure you use the mouse to point and
select each cell reference.)

 • Manually check the calculations using a calculator.
 • Change the font type to Arial 14 point (pt).
 • Bold the heading and the summary monthly totals.

continued …
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Simple functions
Functions can be used in Excel to perform a variety of mathematical, statistical and 
financial calculations. As well as adding up values, functions can also determine values such 
as the maximum, minimum or average from a range of cells.

Look at the following information about Excel functions.

=SUM(range)

 └ This adds the values specified within the brackets.

=MAX(range)

 └ This returns the highest value from the values specified within the
brackets.

=MIN(range)

 └ This returns the lowest value from the values specified within the
brackets.

=AVERAGE(range)

 └ This returns the average value calculated using the values specified
within the brackets.

=COUNT(range)

 └ This counts the number of items in the range.

=NOW()

 └ This inserts the current time and date.

=RAND()

 └ This inserts a random number between 0 and 1.
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Formula auditing tools
Formula Auditing tools are located under the Formulas tab. They are useful when you are 
investigating errors and working out how to fix them.

Of particular use is the Show Formulas tool, which changes the view so you can reveal or 
hide all the formulas in the spreadsheet. 

Another useful tool is the Trace Precedents tool, which shows where the data in the 
calculations comes from. To use this tool, you first need to select the cell that contains the 
error and then select Trace Precedents. The spreadsheet will show preceding connections, 
as per the following example:

Check calculations
As discussed earlier, it is important that you also undertake manual checks as necessary. 
This means checking values against the original data, using a calculator to verify results and 
discussing problems and calculations with colleagues and supervisors. 

The case study in Practice task 6 shows how important it is to check your calculations. You 
should also consult your supervisor or manager about the calculations and results your 
spreadsheet has recorded.

Task requirements
Most organisations have developed policies and procedures for how reports are to be 
presented. Paying attention to the presentation of your document will enhance the reader’s 
ability to understand it. 

It is also important to ensure that the contents of any reports you are producing are 
accurate. 

As part of the production process, it is necessary to check all information, including:
• names, addresses and phone numbers
• product information and pricing
• dates
• reference details (such as customer number, product code)
• spelling
• figures and calculations
• document-specific facts (such as summary totals, highlighted information for action or

review).
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Use training booklets
There are many ways to learn about computer functions and software packages. You may go 
to a training course to learn a particular computer function or a supplier may instruct you 
in the use of a piece of equipment. You may receive training when you start a new job.

Training courses usually provide a comprehensive set of instructions or notes that are worth 
keeping for future reference.

Practice task 7
Read the case study, then answer the questions that follow.

Case study

Chinh works as an administrative assistant in a small manufacturing organisation. One of his 
tasks is to create Excel spreadsheets for his supervisor.
When creating spreadsheets, Chinh often needs to use Excel Help to answer questions about 
software functionality. If he is unsure of a screen icon’s function, he points to the icon with his 
mouse and reads the Help bubble.
Recently Chinh attended a two-day Excel training course at a local community centre. He kept 
the training booklet given out and stores it on his bookshelf. It has a handy index at the back 
for quick solutions to problems. He has also photocopied pages from various manuals he has 
found around the office and placed them in a Help folder on his desk.
Sometimes Chinh experiences software function problems that cannot be solved using Excel 
Help. He then uses Microsoft’s support website to find a solution or refers to the paper-based 
material he has gathered.

1. If Chinh experiences software functionality problems, where does he go for help?

2. Describe how Chinh uses paper-based manuals for help.

3. If you experience a software problem when creating a spreadsheet, describe the steps you
should take to solve the problem.
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Part C
Recreate the following ‘Staff Salaries’ spreadsheet by entering the data into each cell. The 
‘Hourly Rate’ is how much each person is paid per hour and the ‘Weekly Hours’ are how 
many hours are worked per week. Use Excel Help facilities to assist you, as needed, to 
produce the spreadsheet.

• Format all the labels so they are Arial, Bold, 10. Add a pale colour to all the cells with
labels. Add a border to the cells ‘Staff Salaries’ and ‘Total Salaries’.

• Use a calculator to work out how much salary Joanne will receive. In D5, write a formula
that calculates Joanne’s salary. Make sure your formula gives the same results as your
calculation. Use Fill to add the values for the remaining salaries.

• All staff are going to receive a salary raise of 15 per cent per week. The ‘Salary Rise’
column is going to show 15 per cent of the values in the Salary column. Use a calculator
to work out 15 per cent of Joanne’s salary. In E5, write a formula that calculates 15
per cent of Joanne’s salary. Make sure your formula gives the same results as your
calculation. Use Fill to add the values for the remaining salaries.

• The ‘New Salary’ column is going to hold the value of the ‘Salary’ and ‘Salary Rise’
columns added together. Use a calculator to add up Joanne’s new salary. In F5, write a
formula that adds up Joanne’s new salary. Make sure your formula gives the same results
as your calculation. Use Fill to add the values for the remaining salaries.

• The value in B15 is going to contain all the ‘New Salary’ values. Using a calculator, add
up all the new salaries. In B15, write a function within a formula to add up all the ‘New
Salary’ values. Make sure your formula gives the same results as your calculation. Make
the cell reference of B15 absolute.

• Print Preview your spreadsheet. Adjust the alignments of your labels and values until
you are satisfied. Print out your spreadsheet.
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Bar chart
A bar chart displays information as a series of horizontal bars. These charts are useful for 
comparing data arranged in columns or rows. Bar charts show the differences between 
individual items.

The following example shows how monthly sales vary for different departments of a 
retail outlet.

Stacked bar chart
Use a stacked bar chart to compare the values of individual totals to a total across categories. 

The following example compares monthly department sales figures, as well as the total 
overall amount.
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After you insert a chart into your worksheet, you will notice that two new tabs appear when 
you click the chart: Design and Format. The Layout tools also appear next to the chart.

Chart tools
Design tools enable you to change the type of chart selected, choose the style and layout, 
alternate the view of data between row or column, and check or adjust the data selected.

Formatting tools enable you to alter the general appearance of the chart such as colour, font 
type and font size.

The data table is the data contained in the spreadsheet that the chart draws its 
information from. 

Layout tools enable you to add to and adjust the appearance of the chart by adding titles, 
labels, gridlines and so forth.

3C Use formatting features to modify 
the chart type and layout
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Print Preview
The following steps show how to preview your work in Excel.
1. To preview your spreadsheet or chart, select the File tab , then Print.
2. The preview of the job will appear to the right of your screen and look similar to the following

example:

Be careful when selecting multiple worksheets. If you have a number of worksheets active at 
one time, any data that you alter and input will be repeated on all of the selected worksheets. To 
deactivate multiple selected worksheets, simply click on one worksheet name. This will then become 
the active worksheet.
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Enhance speed and accuracy
When producing reports and charts in Excel, it 
is important that you undertake tasks in a timely 
and efficient manner. Keeping to time lines is one 
aspect; another is using the software appropriately 
and efficiently to save time and ensure the accuracy 
of data.

Use shortcut menus (right-click mouse button) to 
bring up quick commands for undertaking actions. 
Use shortcut keys to undertake actions quickly (for 
example, Ctrl X to cut, Ctrl V to paste). Familiarise 
yourself with the tools available in the ribbons and 
the groups of tools under each tab. If you think 
there should be an easier way of doing something, 
there probably is. Search the Excel Help facility for 
assistance.

Use the numeric keypad on your keyboard for data entry of values. Although Excel is 
mainly used for entry of numbers, learning to improve your typing speed and accuracy can 
help. Learning to touch-type may be a way to improve your typing speed.

Organisational time lines
In a workplace, you will often be required to meet specific deadlines. Your supervisor may 
tell you what the deadline is for completing set tasks (for example, prepare a draft summary 
report by 2.00 pm) or you may have regular deadlines for common tasks (for example, on a 
monthly basis, create a report of customers whose invoices are unpaid and overdue) or there 
may be financial requirements (for example, a summary report of GST costs). It is important 
to adhere to organisational time lines for the efficient running of the business.

If for some reason a deadline may not be met or you have conflicting work priorities, discuss 
this with your supervisor. However, do not leave it until the last minute. Your supervisor 
may be able to help you by making suggestions about how the deadline can be met or they 
may be willing to adjust the deadline.

Using a diary system and a to-do list can help you prioritise tasks and be aware of the time 
lines required for set tasks.

Time lines agreed with an internal or external client
Most organisations have a range of clients, who are either internal or external. Internal 
clients are those who work in the same organisation, such as work colleagues, people in 
other departments, managers and supervisors. External clients are those who are outside the 
organisation, such as customers and suppliers.

In many cases, time lines are set and agreed with your clients, both internal and external. If 
you agree to a deadline for completing a task, it is important that you meet it and if you can’t, 
speak to your supervisor and the client. Your supervisor may be able to make suggestions that 
you have not thought of to help you meet the deadline. Speaking with your client will allow 
you to discuss the issue/s with them and may help you to adjust the deadline.

Meeting a deadline demonstrates your competence in undertaking tasks; it also shows 
professionalism on the job. When deadlines are being set, be sure that they are both 
achievable and realistic.
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Example: shared directory
To set up a shared directory, you must first allocate a shared network drive. Your IT coordinator can 
help with this.
The first place to organise a directory is at the folder level. Folders have a tree-like structure that 
branches from a parent directory to sub-folders in a hierarchical structure.
The following example shows the structure of a shared directory.

In this structure, the server has three folders for three separate work groups: Group A, Group B and 
Group C. Group C has three major folders: Procedures, Personnel and Projects. The Projects folder 
includes: Project A, Project B and Project C. Project C has two spreadsheets: ProjectC_time lines.xlsx 
and ProjectC_research1.xlsx. 
The file path for retrieving a file starts at the server and ends when the correct file is located. For 
example, to reach ProjectC_time lines.xlsx, the file path to follow is  
C:\Group C\Projects\Project C\ProjectC_time lines.xlsx.
In Microsoft Excel 2013, the spreadsheet extension is .xlsx.
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This learning checkpoint allows you to review your skills and knowledge in finalising 
spreadsheets.

Part A
Read the case study, then complete the tasks that follow. Use shortcut keys and menus to 
assist in maximising the efficiency of the software.

Case study

Mario works as a personal assistant for a manager in a large organisation. His manager 
asks him to produce a spreadsheet of customer information. The spreadsheet must list 200 
customers and their accounts. It must also calculate a 10 per cent interest charge on the 
accounts and display customers’ new balances. The spreadsheet needs to be ready in two 
days. The following table lists five customers that Mario has to enter:

Customer information

Customers Balances

Sanchez $2,300.00

McGregor $4,000.00

Cunningham $5,000.00

Wijerwadene $4,500.00

Taylor $2,500.00

1. Prepare a checklist of all the tasks Mario will need to do to make sure the worksheet is
completed on time.

Learning checkpoint 4 
Finalise spreadsheets


